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Hier ist meine Gliederung:

Zuerst kommt die Vorbereitung: ich werde erklaren warum man mit
Programmieren Uberhaupt anfangt, wie sich Programmiersprachen C und C++
unterscheiden und welche Entwicklungswerkzeuge man braucht; dann erzahle ich,
wie man Programme unter Linux kompiliert und ausfuhrt, dann wie das make-
Programm und der Debugger funktionieren, dann wie man den Programmierprozess
einfacher und schéner mit Entwicklungsumgebungen KDevelop und Eclipse machen
kann. Und zum Schluss kommen Zusammenfassung und meine Quellen.

Bevor ich anfange, mochte ich euch darauf aufmerksam machen, dass mein
Vortrag keine EinfUhrung in die Programmierung mit C und C++ st
Selbstverstandlich werde ich versuchen, einige Begriffe moglichst einfach zu
erklaren: dabei werden kleine C/C++ Beispielprogramme sehr hilfreich. In der ersten
Linie wird aber die Programmierung selbst stehen und zwar unter Linux.
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o

Motivation
» keine bendtigte Anwendung
> keine zufriedenstellende Anwendung

» Vereinfachung bestimmter Aufgaben

> Fun
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Motivation:

Muss man programmieren kdnnen, um mit Linux zu arbeiten? Hier lautet die
Antwort definitiv: Nein. Die Zeiten, in denen es notwendig war, sich zum Allround-
Programmierer fortzubilden, um Linux Uberhaupt zum Laufen zu bringen, haben wir
hinter uns. Naturlich bendtigt man gewisse Computerkenntnisse, um Linux zu
administrieren, aber wenn mal alles lauft (oder von jemand anderem zum Laufen
gebracht wurde), ist Linux nicht schwerer zu handhaben als andere Betriebssysteme,
die gern mit ihrer Benutzerfreundlichkeit hausieren gehen.

Wieso sich dann mit Programmierung beschaftigen? Ein  paar
Programmierkenntnisse helfen in vielen Situationen, z.B.: es gibt keine Anwendung,
die man brauchte oder die existierende stellt nicht zufrieden oder man will eine
bestimmte Aufgabe vereinfachen, um stumpfsinnige Arbeit zu vermeiden. Und
Programmieren ist naturlich Fun - Bergsteigen, Schifahren oder Zeichnen gefallen
den Leuten, die sich dafur interessieren. Es gibt aber auch andere, die den
erhabenen Einblick in "eine innere Welt, wo niemand jemals zuvor gewesen ist",
nicht verpassen wollen.

Unter Linux stehen mehrere Programmiersprachen zur Verfugung. Warum es
sich lohnt, sich mit C oder C++ zu beschaftigen, erklare ich gleich.



Kurzvorstellung
v C

machtig, flexible, portabel,"Hauptsprache" unter Linux
Beispiel: LinuxKernel

v C++:
Obermenge von C, Objektorientierung

Beispiel: KDE
@ C++

Abb.1: C++ - Obermenge von C

Bemerkung: keine Einstiegssprachen
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Die Programmiersprache C ist machtig und flexible: ihr Ersatzbereich ist
unbeschrankt.

C ist portabel: ein Programm, geschrieben fur ein bestimmtes
Computersystem, lauft auch auf einem anderen Computersystem.

C ist die "Hauptsprache” unter Linux: weil der Linuxkernel in C geschrieben ist
und ein Grofteil der zu einer typischen Linux-Distribution gehérenden Programme
auch.

Und was ist mit C++7?

C++ ist eine Obermenge von C, das heilt, sie hat alle Syntaxeigenschaften
von C, aber noch einige z.B. Objektorientierung. ("Objektorientierte Programmierung"
befasst sich mit Programmen, die Klassen verwenden. Wir kdnnen uns ein Objekt als
eine selbstandige Instanz vorstellen, die ihre eigenen Daten verwaltet und ihre
eigenen Funktionen besitzt.) C++ ist auf vielen Plattformen inkl. Linux sehr haufig
anzutreffen. Beispiel unter Linux ist KDE, welche komplett in C++4+ mit Hilfe der
Bibliothek Qt geschrieben ist. Man schreibt viele kommerzielle Programme in C++.

Eine kleine Bemerkung: bitte, Vorsicht, C und C++ sind keine
Einstiegssprachen, keine der beiden ist eine gute Wahl, um sie als erstes zu lernen.
Dafur ist z.B. Python sehr gut geeignet. Eine EinfUhrung in die Sprache hatten wir vor
einigen Wochen.



Entwicklungswerkzeuge

Text-Editor (vim, emacs, etc)

Compiler (GCC)

make-Programm

Debugger

Ubuntu: Paket <build-essential>
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Um mit Programmieren unter Linux anzufangen, braucht man einige
Programmierwerkzeuge:

- einen Text-Editor (z.B. vim oder emacs. Emacs ist fir das Programmieren
ganz besonders geeignet, weil er so viele Erweiterungen erhalt, dass man zum
Programmieren eigentlich nichts anderes mehr bendtigt);

- einen Compiler (der Standard-Compiler unter Linux ist GCC. Das ist GNU
Compiler Collection (wurde in C geschrieben, "Collection", weil er mehrere
Programmiersprachen bietet) und

- solche hilfreiche tools wie z.B. das make-Programm und den Debugger (fur
Fehlersuche).

Bei Ubuntu sind alle diese Programme in einem Paket <build-essential>
zusammengefasst. Spater kann man vielleicht weitere Bibliotheken oder Developer-
Pakete brauchen aber fUr den Anfang sollte das einmal reichen.
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Kompilieren/Ausfilhren

1. eine Datei mit dem Quellcode erstellen
$ emacs erstes_programm.cpp

2. den Quellcode kompilieren
$ g++ erstes_programm.cpp

3. das Programm ausfuhren
$ ./a.out

Anmerkung:
C: ersetze g++ durch gcc

Proseminar: Linux fir Umsteiger C/C++-Programmentwicklung unter Linux 8/31

Wie entwickelt man ein Programm?

1) Zuerst erstellt man mit einem Text-Editor eine Datei mit dem Quellcode.
(Quellcode ist was wir bei unseren Programmen selbst eintippen, also, Text eines
Computerprogrammes).

2) Dann Ubersetzen wir diesen Quellcode mit einem Compiler in
Maschinencode. Wenn es keine Fehler gibt, wird die Datei gelinkt und eine
ausfuhrbare Datei namens a.out erzeugt.

3) Und zum Schluss fuhrt man das Programm aus, um festzustellen, ob es wie
geplant funktioniert.

Bei C-Programmen muss man g++ durch gcc ersetzen.



Kompilieren vs. Linken

#include <stdio.h>
A . Lexikalische Analyse Syntaktische Analyse Semantische Analyse
int main() /
<stdio.h>|
printf("Hallo Welt'\n"); . / \
exit(0); Compiler* int main() < > <
} printf("Hallo We sdtio.h stdio.h
prog.cpp String
Quelltext
Analysephase
Header-Datei(en) ‘
Zwischencode Optimierung Objektdatei(en)
_syscall: _syscall: 00110101
int 0x80 int 0x80 10011001...
ret ret —» Linker = prog
msg db “Hallo Wel msg db “Hallo Wel *.0
len equ $ - msg lenequ $ - msg -
ausfuhrbares
Programm
Synthesephase 9
Info: http://de.wikipedia.org/wiki/Compiler 9
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Diese Folie zeigt die Aufgaben vom Compiler und Linker.

Moderne Compiler werden in verschiedene Phasen gegliedert. Im Wesentlichen
lassen sich zwei Phasen unterscheiden: Analysephase und Synthesephase. Wahrend
der Analysephase werden die Quelltexte und Header-Dateien analysiert, strukturiert
und auf Fehler gepruft und wahrend der Synthesephase wird der Zwischencode
erstellt und optimiert und schlie8lich Objektdateien erzeugt.

Ein weiterer Arbeitsschritt, der haufig automatisch mit ausgefuhrt wird, heifst
das Linken und wird vom Linker gesteuert. Der Linker verbindet einzelne
Programmmodule zu einem ausfuhrbaren Programm. Die meisten Programme
enthalten Bestandteile oder Module, die in anderen Programmen Verwendung finden
kdnnen. Mehrere kompilierte Module mit Funktionen (so genannte Objektdateien)
kdnnen zu Funktionsbibliotheken (Programmbibliotheken) zusammengefasst werden.
Der Code wird vom Linker zum Hauptprogramm hinzugeflgt, falls die entsprechende
Funktion benétigt wird. Um ein Programmmodul in einem anderen Programm
verwenden zu kdénnen, mussen die symbolischen Adressen der Funktionen und
Variablen des Moduls in Speicheradressen umgewandelt werden. Genau diese
Aufgabe Ubernimmt der Linker.



Name der Ausgabedatei

$ g++ erstes_programm.cpp -0 erstes_programm
$ ./erstes_programm

Mehrere Quelltextdateien

$ g++ dateil.ccp datei2.cpp /gen/datei3.cpp -0 prog
$ ./prog

10
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Standardmafiig wird immer der Name "a.out" flur die Ausgabedatei verwendet.
Das kann man jedoch Uber den Parameter "-0" andern.

Wenn ein Programm aus mehreren Quelltextdateien besteht, kann man auch
mehrere hintereinander angeben.
$ g++ dateil.ccp datei2.cpp /gen/datei3.ccp -0 prog
Also besteht das ausfUhrbare Programm “prog” aus drei Dateien: dateil.cpp und
datei2.cpp, die sich im gleichen Verzeichnis befinden und aus der Datei datei3.cpp,
die sich im Verzeichnis /gen befindet.



Wichtige Parameter fiur gcc

Option Bedeutung

L
-0 Bestimmt den Namen der Ausgabedatei (Standard: ,,a.out”)
-C Der Quellcode wird nur kompiliert, aber noch nicht gelinkt
-g Hinzufligen von Informationen flr den Debugger
-Wall | Ausgabe von Warnungen bei "unschénem" Code
-V Gibt die Kommandos und Schritte, die der Compiler ausfihrt

(Préapozessor, Compiler, Linker, etc.)
\J
11
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Der GNU-Compiler kennt viele anderen Optionen. Hier sind die Wichtigsten.
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Malke-Progranm

Projekt: main.cpp, square.cpp, square.h
Ziel: myprogram

Abhangigkeiten:

P main.cpp - main.o ~
square.h myprogram
L square.cop - square.o »
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Es gibt viele Programmiertools, die die Arbeit des Programmierers erleichtern.
Ein der wichtigsten ist make-Programm. Es hilft in Programmen aus mehreren
Quelltextdateien. Wenn man an einer davon etwas andert, muss man dann alle
anderen neu kompilieren? Nein, muss man nicht. "Make" kompiliert nur die
geanderte Datei.

Beispiel: wir haben ein Projekt mit main-Funktion main.cpp, Definition der
Funktion square.cpp und ihrem Prototyp square.h.

Um myprogram zu erstellen, braucht man main.o und square.o.
Um main.o zu erstellen, braucht man main.cpp und square.h.
Um square.o zu erstellen, braucht man square.cpp und square.h.

Also, sehen wir die Abhangigkeitsliste:
Das Ziel - myprogram, seine Abhangigkeiten - main.o und square.o, usw.

Das alles sollten wir nun als Makefile-Datei zusammenfassen.



Wichtige Regeln

eine Regel, Definition oder Befehl - pro Zeile
<Ziel>: <Abhangigkeit>
TAB $ <Befehl>

vV V V VYV

# Kommentar
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Wichtig sind einige Regeln:

1) Pro Zeile steht immer nur eine Regel, Definition oder Befehl

2) Das Ziel steht vor dem Doppelpunkt, dann kommt mindestens ein
Leerzeichen und dann die Abhangigkeit

3) Man sollte angeben, durch welchen Befehl das Ziel aus der Quelle erzeugt
werden kann. Zeilen mit ausfiuhrbaren Befehlen muss man mit einem
Tabulatorzeichen einrucken

4) "#" Doppelkreuz - fur Kommentare



Makefile

#makefile-Datei fur myprogram

#main.o square.o -> myprogram
myprogram: main.o square.o
$ g++ main.o square.o -0 myprogram

#main.cpp square.h -> main.o
main.o: main.cpp square.h
$ g++ main.cpp -c

#sqr.cpp square.h -> square.o
sqr.o: square.cpp square.h
$ g++ square.cpp -c

#l0sche alle Objektdateien ($ make clean)
clean:
$rm-f*o

15
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Hier ist die fertige Makefile-Datei.

Um die Makefile-Datei zu verwenden, muss man den Befehl "make" eingeben.
Das Ergebnis ist die ausfuhrbare Datei "myprogram". Wenn wir jetzt etwas an einer
Datei andern, mussen wir nicht jede einzelne Datei neu kompilieren, es ist genug,
den Befehl “make” eingeben, um die neue Version des Programms auszufuhren.



Debugger (Fehlersuche)
“bug” - Laufzeit-Fehler

» gdb (konsolenbasiert)
» ddd (graphisch)

Hinzufagen von Info fur Debugger
$ g++ bug program.cpp -g -0 bug_program

Aufruf des Debuggers
$ ddd bug_program

16
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Nachstes Tool ist Debugger.

Wahrscheinlich habt ihr auch die Erfahrung gemacht, dass eure Programme
beim ersten Mal oft nicht funktionieren. Tatsachlich ist es selten, ein nicht triviales C/
C++-Programm zu schreiben, das beim ersten Mal, als man versucht, es
auszufuhren, keine Fehler enthielt.

Es gibt zwei Arten von Fehlern:

- Compilerzeit-Fehler, das sind Fehler, die der Compiler findet, sie sind relativ
leicht zu behen und

- Laufzeit-Fehler, diese Fehler kann der Compiler nicht finden, er kompiliert das
Programm, es lauft aber leider nicht wie der Programmierer es geplant hat. Solche
Fehler nennt man auch "Bugs" und sie sind schwieriger zu finden...

Naturlich kann man aufhéren zu programmieren. Es gibt aber eine Alternative:
man kann die Fehler mit dem Debugger finden und beheben.

Unter anderen stehen unter Linux zwei beliebte Debugger: “gdb” und “ddd” zur
Verfugung.

“gdb” ist ein konsolenbasierter Debugger und “ddd” - sein graphischer
Frontend.



* View -> Execution Window - Konsolenfenster
* Break - einen Haltepunkt setzen
®* Run - das Programm ausfuhren
* Next - nachste Anweisung

® Step - in eine Funktion hineinspringen

17
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"ddd"-Optionen:

"Break" - Haltepunkte (engl. breakpoints):
Der Debugger halt das Programm an, wenn die Ausfuhrung auf einen Haltepunkt
stoRt. Also kann man nur einen Teil des Programms ausfuhren, um festzustellen, wo
genau das Problem auftritt.

"Next" - Nachster Teil (Einzelschrittausfuhrung):
Mit "Next" kann man das Programm zeilenweise ausfuhren, um jeden einzelnen
Ausgabebefehl zu kontrollieren. Der Punkt der Ausflhrung wird nur zum nachsten
ausfuhrbaren Befehl verschoben. Dabei werden z.B.Deklarationen uberspringt, weil
eine Deklation keine Anweisung ist und wird nicht ausgefuhrt. Eine Deklaration
reserviert einfach Speicherplatz fur eine Variable.

"Step" - Uberspringen (engl. stepping over):

Wenn das Programm innerhalb einer Funktion abstlrtzt, enthdlt die Funktion
entweder einen Fehler oder die Argumente, die an die Funktion Ubergeben wurden,
sind nicht korrekt. "Next" behandelt einen Funktionaufruf wie eine einzelne
Anweisung. Eine Funktion besteht jedoch selbst aus einer Reihe von C/C++-Befehlen.
Deswegen muls man in die Funktion hineinspringen und jeden Befehl innerhalb der
Funktion ausfuhren, um besser zu sehen, was passiert. Diese Funktionalitat wird
durch die "Step"-Anweisung des Debuggers zur Verfligung gestellt.
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Entwicklungsumgebungen

(IDEs - Integrated Development Environments)
Merkmale:

> 4inl
> Editor -> Syntaxeinfarb
» erzeugte Programme -> sofort gestartet
» makefiles -> automatisch erzeugt
> Codestellen mit Fehlern -> automatisch angezeigt
> “Breaks” und “Steps” -> im Editor aktiviert
> alle Dateien eines Projekts -> in einem Dialog
» Versionsverwaltung...

19
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Unter Linux ist ja schon, dass man alles so automatisieren kann wie man es
will, z.B. von der Kommandozeile aus kompilieren usw. Aullerdem, wenn man das
"von Hand" macht, lernt man besser, was so gemacht werden muss. Es kann aber
trotzdem fur einige Entwickler etwas muhsam sein, immer mit den
Kommandozeilentools zu arbeiten. Bequemer und produktiver wird die
Programmierung mit integrierten Entwicklungsumgebungen - Integrated
Development Environments oder kurz IDEs.

Diese verfugen alle Uber folgende Merkmale:
-4 in 1 ("four in one”): Editor, Compiler, Make-Programm und Debugger sind unter ein
einheitliches User Interface gepackt
- Der Editor hat Syntaxeinfarbung
- Die erzeugten Programme kdénnen sofort aus der IDE gestartet werden
- Makefiles werden automatisch erzeugt
- Codestellen, an denen der Compiler Fehler findet, werden automatisch angezeigt
-Bei der Fehlersuche mit dem Debugger werden die gerade durchlaufenen Quelltexte
im Editor angezeigt; Haltepunkte und Einzelschritte kdnnen dort aktiviert werden.
- Die Dateien, die zu einem Projekt gehdren, werden Uber einen Dialog festgelegt.
- Die Versionsverwaltung ist in die IDE eingebunden, so dass die Dateien Uber den
Editor aus- und eingecheckt werden kénnen.

Ich will euch heute zwei IDEs vorstellen, die alle diese Kriterien erfillen (und
noch mehr): das sind KDevelop und Eclipse.



KDevelop

Vorteile:

» Auto-Vervollstandigung

* Assistenten fur Projekte, Klassen, Dateien

* Doxygen, CVS

 C, C++, Java, Fortran, Pascal, Perl, Python...
» externe Programme in Menus

* Plugins

» Qt-Designer

* grolSe Projekte...

Nachteile:
* nicht einfach fur Anfanger
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KDevelop ist die integrierte Entwicklungsumgebung des KDE Projekts.

KDevelop bietet:

- Auto-Vervollstandigung (z.B., wenn eine Klasse einige Methoden besitzt, kann
man beim Code-Eintippen aus denen auswahlen);

- Assistenten fur das Erstellen neuer Projekte, Klassen oder einzelner Dateien.
Sie helfen beim Erstellen: was will man erstellen? "Simple Hello World Program” oder
“Simple KDE Application”? Wie heilst der Entwickler? Wie lautet seine/ihre e-mail
Adresse? Welche Lizenz mochte er/sie fur sein/ihr Program? usw;

- Doxygen - das Dokumentationssystem, damit kann man fundierte
Documentation fur API-Funktionen (Application and Programming Interface)
erzeugen;

- CVS - Versionskontrollsystem: es bewahrt den ganzen Quellcode in einem
Platz, der "Repository" (Lager) heilst, so, dass jeder den Code eines bestimmten
Zeitpunktes sehen kann, sehr praktisch, weil der Code nicht blockiert sein muss, was
die parallele Arbeit von Entwicklern ermaglicht;

- eine Vielzahl von Programmiersprachen (C, C++, Java, Fortran, Pascal, Perl,
Python, etc.) - man kann mehrsprachige Applikationen entwickeln;

- laBt sich durch Plugins erweitern;

- externe Programme lassen sich in die Menus einbinden;

- Qt-Designer. Qt ist eine Klassenbibliothek fur die Entwicklung von grafischen
Benutzeroberflachen (Die Abklurzung Qt wird offiziell wie das englische Wort "cute"
[kju:t] ausgesprochen. Dieses Wort soll die Ansicht der Entwickler ausdricken, dass
der Quelltext suf3, hubsch aber auch pfiffig sein sollte).

KDevelop eignet sich durch seinen Funktionsumfang und seine Erweiterbarkeit
far groBe Projekte, macht es aber Anfangern schwer einen Zugang zum gesamten
Funktionsumfang der Entwicklungsumgebung zu finden.



{Develop

Installation:

v Ubuntu:
Hinzufugen/Entfernen KDevelop

v Pakete:
<automake> (>1.6)
<autoconf> (>2.5)
<build-essential>
<kdevelop-doc>

21
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Installation: Unter Ubuntu genugt es, mit HinzuflUgen/Entfernen KDevelop zu
installieren. Nach der Installation kann es sich herausstellen, dass wir auf die Option
“Run automake & friends and configure” nicht zugreifen kdénnen. Dies liegt daran,
dass KDevelop bei Automake eine Version hoher als 1.6, bei Autoconf hoher als 2.5
bendtigt, um richtig funktionieren zu kénnen. Dieses Problem kann man allerdings
einfach beheben, indem man entsprechende Pakete nachinstalliert. Wenn das Paket
<build-essential> installiert ist, kann man sich dann Uber automake und autoconf
keine Sorgen machen. Was machen diese Programme? automake erstellt
automatisch makefiles und autoconf braucht man, um die Generierung automatisch
an die lokale Hard- und Softwareumgebung anzupassen. Es empfiehlt sich auch die
Dokumentation zu installieren, da sie uns beim Schreiben einer Applikation hilft -
selbst wenn die Applikation einfach ist.



KDevelop
Oberflache

abisco - file:

EQQlhEdo

L & [*) (Global Namespace)

File Edit View Project Build Debug Bool

:/home/pietz/devel/abisco/src/abisco/dbase.cpp - KDevelop.

ks Window Tools Setings Help

OEBIDAAR RLESLRES

~[#(Classes) ~ /4| (Functions) ~J8ls,

QTdd R
[~ #DBase

o DBase(QFil
% columnLeng
3 columnTypé

Bx

P getHeaderl
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PgetNextRow [T
P getRecordL -
»getVersion(
®headerOK()
< nextRow()

®numCols()

®numRows()

1
if (file

[ & [EiClasses| = | |

3

(170}

% header_len,
“headers
“pindex
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o record_leng™

|

2| sadbasen | 9 .classeshiml | 9 dbase.cop

1
if (file->isOpen

@ getColNam: T file->c

lose () ;
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+ELIBC (umn.edu)

ECurrent Project
E3Bookmarks

“Ex)
2 Contrte [index | [

+ @0t Designer Man.
+>open (10_Feadonly)) { +E3Qt Assistant Man.

+E&Guide to the Qt Tr... =
+@Qt Designer3an... |~
+-83C++ bugs (GCC)

+E3LIBSTDC++ (gec.

sl@[h[D[#[e[R][s][Q[a][e][C]s[a]6]

Line: 220 Col: 20 INS NORM
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Das ist die Oberflache von KDevelop. Auf der linken Seite kann man zwischen
verschiedenen Projektdateien navigieren. Im Hauptfenster ist der Editor. Auf der
rechten Seite - der Hilfebrowser. Mittels Registerkarten kann zwischen den Ansichten
gewechselt werden. Am unteren Teil des Fensters kann man die Ausgabe der
verschiedenen externen Programmen wie make-Programm, Debugger und sonstige I/

O Operationen ablesen.

Abb.

4 Oberflache von KDevelop

C/C++-Programmentwicklung unter Linux
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KDevelop

Hello World!
Simple KDE Application

Projekt erzeugen:
Project->New Project->C++ ->KDE->Simple KDE Application

Projekt ubersetzen:
Build->Run automake & friends T
Build->Run Configure
Build->Build Project
Build->Install (as root user)

Starten:
Build->Execute Program

Abb.5 Die einfache KDE Anwendung

Info: http://women.kde.org/articles/tutorials/kdevelop3/de/index.html
23
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Eclipse
eine universelle Platform

* IBM-Geschenk

* Konsortium: IBM, Borland, Intel, Nokia, HP, SAP AG

« verschiedene Programmierparadigmen und
Technologien

e Plugin-Architektur

Weitere Merkmale:
Resourcenverwaltung, Aufgabenverwaltung
Problembehandlung, Hilfesystem, Assistenten
Codevervollstandigung, Refactoring, lokale Historie
intelligente Korrekturvorschlage, RCP...

24
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Die nachste IDE ist eine der neuesten und viel beachteten IDEs unter Linux -
Eclipse. lhre erste Version wurde im Jahr 2001 freigegeben. Angeklindigt wurde
Eclipse von IBM als ein 40-Millionen-Dollar-Geschenk an die Open-Source-Gemeinde.
Also steht jetzt der gesamte Code von Eclipse als Quellcode zur Verfigung und kann
leicht eingesehen werden. Das Eclipse-Konsortium besteht aus Uber 150 Mitglieder:
IBM, Borland, Intel, Nokia, Hewlett Packard, SAP AG (Microsoft ist nicht dabei).

Was genau ist Eclipse?

Die Idee von Eclipse besteht darin, dass heutige Entwicklungsprojekte aus
verschiedenen Programmierparadigmen und Technologien wie z.B. C++, Java,
Python, HTML oder XML auskommen. Deswegen modchte Eclipse eine universelle
Plattform sein, die durch Plugins viele andere Werkzeuge einbinden kann. Weitere
Merkmale sind: Resourcenverwaltung, Aufgabenverwaltung, Problembehandlung,
Hilfesystem, verschiede Assistenten, Codevervollstandigung, Refactoring (Funktion
fur die Umformung von Programmen); das Fuhren einer lokalen Historie, die eine
Ruckkehr zu friheren Codeversionen erlaubt; intelligente Korrekturvorschlage; Rich
Client Platform (RCP) - generische Plattform flir eine weite Klasse von
Anwendungen... Und das ist nur die Spitze des Eisbergs. Durch sein sehr offenes
Plattformkonzept ist Eclipse eine sehr interessante IDE und eignet sich fur kleine bis
mittelgroRRe Projekte.



Eclipse

Installation:

v Java Runtime Environment
Paket: <ubuntu-restricted-extras>
Info: http://wiki.ubuntuusers.de/Java

v Eclipse IDE for C/C++ Developers
http://www.eclipse.org/downloads/
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Die Installation von Eclipse ist nicht schwierig. Unter Ubuntu braucht man Java
Runtime Environment. Dieses sorgt dafir, dass in Java geschriebene Programme auf
jeder Plattform ausgefuhrt werden kdnnen. Normalerweise reicht es das Paket
<ubuntu-restricted-extras> zZu installieren. Info findet man hier:

http://wiki.ubuntuusers.de/Java. Und dann sollte man das Ganze von dieser Seite
herunterzuladen:

Eclipse IDE for C/C++ Developers
http://www.eclipse.org/downloads/
Das kann unter /opt ausgepackt werden und ist sofort lauffahig.



Abb.6: Eclipse Workbench
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Das ist das Hauptfenster von Eclipse, das man “Workbench” nennt. Der
Workbench ist die Oberflache von der man alles regeln kann. Wie der Workbench
aussieht, kann man selber festlegen. Standardmassig gibt es folgende Aufteilung:

- Im ersten Bereich findet man einen Uberblick seiner/ihrer Projekte. Man kann
zwischen den Projekten navigieren, Dateien 6ffnen, neue Dateien oder Ordner in den
Projekten erstellen, etc.

- Im zweiten Bereich ist der Editor. Wenn man den Sourcecode schreibt, wird er
farbig hervorgehoben. Wenn Eclipse Fehler erkennt, markiert er sie und schlagt in
machen Fallen Losungen vor.

- Im dritten Bereich findet man die Outline: Wissenswertes Uber die im Moment
geoffnete Datei. z.B. bei einer Klasse sieht man hier die Attribute und Methoden.
Durch einen Klick auf die Methode kommt man an die Stelle im Quelltext wo sie
implementiert ist.

- Im vierten Bereich werden Ausgabe und Fehler aufgezeigt.
Die einzelnen kleinen Fenster, die Funktionen bereitstellen, werden als Views
bezeichnet. Durch Anklicken sind sie aktiviert, durch Doppelklick kann man sie

maximieren und minimieren.

Die Anordnung der momentanen Tools und den Umfang der Tools bezeichnet
man als Perspektive.



Eclipse
Hello World C++ Project

Projekt erzeugen:
File -> New -> Project -> C++ Project -> Executable ->
Hello World C++ Project -> Finish

Projekt ubersetzen:
Project -> Build Project

Starten:
Run -> Run as ->1 Local C/C++ Application
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Gliederung

vVorbereitung
v Kompilieren/Ausflhren
vTools
* make-Programm
* ddd-Debugger
v Entwicklungsumgebungen
* KDevelop
* Eclipse
v Fazit
* Quellen

C/C++-Programmentwicklung unter Linux
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razit

Q)

Was macht Linux fars Programmieren so attraktiv?

» komplette Programmier-Umgebung

Compiler, Interpreter, fast alle gangigen Programmiersprachen
Bibliotheken, Debugging- und Automationstools, Editoren

» programmiererfreundliche interne Struktur
nicht kiinstlich verschleiertes System:
“Ich werde daflr sorgen, dass du verstehst wie ich funktioniere.”
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Zusammenfassung.

Gerade eben haben wir gesehen wie man unter Linux programmieren kann.
Am Anfang kann das alles kompliziert vorkommen aber wenn man einige Programme
geschrieben hat, macht man viele Sachen automatisch und arbeitet schnell und
effizient. Mein Ziel war zu zeigen was Linux flrs Programmieren so attraktiv macht.
Ich hoffe, dass ihr jetzt auf diese Frage die Antwort gefunden habt: um in die
Programmierung einzusteigen, ist Linux ganz besonders gut geeignet, denn:

1) Linux kommt mit einer kompletten Programmier-Umgebung: es gibt
Compiler und Interpreter fur fast alle gangigen Programmiersprachen, Bibliotheken,
Debugging- und Automationstools, Editoren wie Sand am Meer. Linux macht die
Entwicklung von Software so leicht wie mdglich.

2) Linux ist in seiner internen Struktur programmiererfreundlich angelegt - man
kann von Haus aus "in das System hineinschauen”, es wird nicht kunstlich
verschleiert, wie die einzelnen Komponenten zusammenwirken. Linux ist das
Gegenteil eines Systems, das sagt: "lch glaube nicht, dass du verstehen kannst, wie
ich funktioniere. Ich werde dafur sorgen, dass du mir hilflos ausgeliefert bleibst und
ich dir wie ein hoheres, uUberlegenes Wesen vorkomme, mit dem du nur Uber
mysteriose Rituale kommunizieren kannst."

Zum Schluss mochte ich sagen, dass das Ganze ein Fass ohne Boden ist... Ich
konnte hier nur eine sehr kleine EinfUhrung geben. Bei Interesse und Bedarf kann
man viel mehr Uber das Thema erfahren. Ich hoffe, es hat euch trotzdem was
gebracht und ihr etwas Spal bei der Sache hattet.

Hier sind meine Quellen. Vielen Dank fur die Aufmerksamkeit und "Happy
Hacking!"
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Quellen

»  Programmieren unter Linux:
http://www.cpp-entwicklung.de
http://www.galileocomputing.de/openbook/linux/

»  Kompilieren/Linken:
http://de.wikipedia.org/wiki/Compiler
http://de.wikipedia.org/wiki/Binder_%28Computerprogramm%29

» KDevelop:
http://www.kdevelop.org
http://women.kde.org/articles/tutorials/kdevelop3/de/index.html
http://www.pro-linux.de/berichte/appfokus/kdevelop/kdevelop.htm

»  Eclipse Workshop und Tutorial:
http://www.admin-wissen.de/eigene-tutorials/programmierung/

»  Onlinekurse fir C und C++ (en/de)
http://www.c-plusplus.de/cms/index.php 31
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Meine Empfehlung fuir den Anfang ware das Buch “cpp-entwicklung”, das man
entweder bestellen oder online lesen kann. Das Besondere an diesem Buch ist, dass
man hier nicht nur etwas Uber die Programmiersprache C++, sondern auch viel Uber
die Werkzeuge (Compiler, Make-Programm, Debugger, etc.) lernt, die fur die
Entwicklung unter Linux zur VerfUgung stehen. Der Autor zeigt, wie man unter Linux
ahnlich bequem wie unter Windows entwickeln kann - ein wenig anders aber dafur
bekommt man fast alles, was man braucht, so gut wie umsonst. Es geht hier aber
nicht um das Geld, sondern um die Freiheit und Zusammenarbeit.



und viel Erfolg

beim C/C++-Programmieren

unter Linux!
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